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Introduction 

Adobe Acrobat X Pro allows users to create, view and edit files in Portable Document Format (PDF).  Acrobat 
enables viewing documents created in various software programs on any computer, with the look and layout 
of the source program intact, like an electronic snapshot. 

 

Open the Program 

Open Adobe Acrobat X Pro to bring up its Getting Started window.   
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Create a PDF File 

In the ‘Getting Started’ menu, you can open an existing PDF file or create a new one.   

1. Click on ‘Create PDF’.  

 

 

 

 

 

 
 
 
 
 
 
 
 
 
2. In the ‘Open File’ dialog box, find the document to open as a PDF and click ‘Open’.  Adobe automatically 

converts the file to PDF format. 
a. It does not matter what type of file you choose; it could be an Excel spreadsheet, Word document 

or even an image. 
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Overview of Work Area 

Adobe Acrobat X Pro opens to display a document window and a navigation pane, along with toolbars and a 
menu bar. The document window displays the PDF documents. The navigation pane is located on the left side 
of the document window and allows you to browse through the PDF.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A. Menu bar 
B. Toolbars 
C. Navigation pane  
D. Document window 
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Acrobat Toolbars 

Acrobat’s default toolbar groupings are Create, File commands, Quick tools, Page navigation, Select, Zoom, Page 
display, Tools, Comment and Read mode. 

 

 

 

1. Create - allows you to create a PDF from an electronic or scanned document.  Also allows you to create a 
PDF portfolio. 

2. File commands - toolbar contains the Open, Save, Print, and Share document buttons. 
3. Quick tools - provide one-click access to common functions in Acrobat.  Customizable. 
4. Page Navigation - toolbar contains the Previous Page, Next Page buttons and Page Number display. 
5. Select - toolbar contains the Select and Hand buttons. 
6. Zoom - toolbar contains Zoom Out, and Zoom in icons and Zoom Value display. 
7. Page Display - toolbar contains the Scrolling Mode and Single Page icons. 
8. Tools pane - access to numerous functions in Acrobat. 
9. Comment pane - allows you to add comments to PDF file. 
10. Read mode - view your document without the clutter of toolbars or task panes. 

Add Tools to the Quick Tools Toolbar 

Tools can be moved to the Quick Tools toolbar from the Tools pane by dragging their 
grabber bars.   The grabber bar appears once you hover your mouse over a tool selection. 
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Review the Navigation Pane Buttons 

The buttons along the left side of the document window are the default buttons.  Each of the buttons opens a 
different panel in the navigation pane. 

 

A. Page Thumbnails – ‘Page Thumbnails’ displays a 
thumbnail view of all the pages in the open PDF 
document. 

B. Bookmarks – ‘Bookmarks’ enables you to jump to a 
specific section or page that’s has been previously 
bookmarked in a PDF document. 

C. Attachments - Attaches files to the PDF document.  
D. Signatures - A digital signature verifies your identity and 

may include a photo or an image of your hand-written 
signature. 

 

 

 

 

 

 

 

 

 

 

Create Simple PDF Files from Inside the Program (if another file is already open onscreen) 

If no file is currently open, you will always see the ‘Getting Started’ window and can create a PDF there.  If a file is 
currently open, you can choose ‘File’ from the menu bar, or you can select the ‘Create’ button from the top row of 
toolbar buttons, to create a PDF file.   
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Creating a PDF using ‘File’ from the menu bar: 

1. Click on ‘File’ from the top menu 
2. Scroll down and select ‘Create PDF’ 
3. From the fly-out menu, select ‘PDF From 

File’. 
4. A dialog box pops up. Select the file that 

you want use and click ‘Open’. 

 

 

 

 

 

Creating a PDF using the ‘Create’ button: 

1. Click on the ‘Create’ button on the toolbar. 
2. Select ‘PDF from File…’ 
3. A dialog box pops up. Select the file that you want to 

use and click ‘Open’.  
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Create a PDF from within Microsoft Word 2010 

In Microsoft Office 2010, you can click on the Acrobat tab to open the PDF toolbar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Click on the ‘Create PDF’ icon and the dialog box will pop up asking you to save your document.  Navigate 
to the directory that will house the document and type the name you want to use. Then click on the 
“Save” button.  

a. When naming your PDF documents, do not use spaces between words. You can use underscores 
to separate the words in your filename (e.g., Acrobat_X_Pro_Intro). 

2. The file will open up in Acrobat X Pro. 
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Create a PDF File in MS Word 2010 and Save It as an Email Attachment 

1. To create a PDF file 
and save it as an email 
attachment, click on 
the ‘Acrobat’ tab. 

2. Click on the ‘Create 
and Attach to Email’ 
icon. A dialog box will 
appear, type in the 
name of the new PDF 
file and click the 
‘Save’ button. 

 

 

 

 

 

 

 

3.  Your default email client 
will automatically open to 
the ‘Mail To/Compose’ 
screen with newly created 
PDF file attached.   

4. Fill in the pertinent email 
information and click the 
‘Send’ button. 
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Convert and Combine Different Types of Files into a Single PDF Document 

There are two different methods for combining files in Adobe Acrobat. The first is the ‘Create PDF Portfolio’ 
method, and the second is the ‘Combine Files into a Single PDF’ method.  This handout will discuss the latter 
method. 

If you have just launched Acrobat X Pro, or if you are in the program but have no files open, 

1. Select ‘Combine Files Into PDF’ from the ‘Getting Started’ window. 
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If you currently have a file open,  

2. Click on the ‘Create’ button from the upper toolbar 
and choose ‘Combine Files Into a Single PDF…’ 

 
 
 
 
 
 
 
 
 
 
 
 
The ‘Combine Files’ window will appear onscreen.  

3. Click on the 
“Add Files” 
button. A 
dialog box 
will appear. 
Then 
navigate to 
the 
directory 
that holds the files that you want to combine. These files do not necessarily have to be in PDF format; 
they can be files in various formats, such as Excel or Word, or they can even be image files.  

4. Hold down the Control key and click once on each file you wish to add.  If you are adding several files in a 
row, you can hold down the Shift key and click once on the first and last file to add all the files. 

5. Click the ‘Add Files’ button.  Your files will be displayed in in the ‘Combine Files’ window. 
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6. To change the position of a file in the list, click on any filename and then use the ‘Move Up’ or ‘Move 
Down’  button to shift its position.   

7. To remove a file from the list, highlight a file and click on the ‘Remove’ button. 
8. When ready, click the ‘Combine Files’ button.   

All files are converted to PDF format, and the consolidated PDF document is named ‘Binder1’ by default.   

To rename the file,  

1. Go to ‘File’ on the menu bar and choose ‘Save As’.  
2. In the ‘Save As’ dialog box, rename your newly combined PDF document and press ‘Save’. 
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Open an Existing File in Adobe Acrobat 

Click on ‘Open…’ on the ‘Getting Started’ screen and locate your file. 
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Re-Order Pages within A PDF Document 

To re-order pages in a PDF document involves a quick and easy drag-and-drop action.  

1. Open your multi-page document in Adobe 
Acrobat. 

2. Notice the page thumbnails arranged in a 
vertical line along the left side of the 
window. 

a. If the page thumbnails are not 
displaying, click on the ‘Page 

Thumbnails’ icon    to display 
them. 

3. Scroll to the page that you want to re-
order. Click on the thumbnail for that page 
to highlight it, and then drag the thumbnail 
up or down to the desired location.  
Release the mouse button. 
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Convert Web Pages into PDF Files 

 
Adobe Acrobat allows you to capture or convert selected content on a web page, entire web site or several layers 
of a multipage website. Since the web pages are converted into PDF format, they can be saved, printed or emailed 
to others. 

 

1. Click on the ‘Create’ button from the upper toolbar and choose ‘Create PDF from Web Page’. 
 
 
 

Configure How PDFs Display in Your Internet Browser 

 

To set your internet preferences in Adobe Acrobat, 

1. Choose ‘Edit’ on the top menu and select ‘Preferences’. 
2. From the menu on the left-hand side, select ‘Internet’. 
3. In the ‘Web Browser Options’ section, check the options that best suit your needs. 

a. Display PDF In Browser - allows any PDF opened from the web to display inside the current 
browser window. If this option is not selected, PDF documents open in a separate Acrobat 
window. 

b. Allow Fast Web View - downloads PDF files for viewing one page at a time.  If this option is not 
selected, the entire file downloads before it is displayed. 

c. Allow Speculative Downloading in the Background – allows a PDF file to continue downloading 
from the web, even after the first requested page displays.  Downloading in the background stops 
when any other task, such as paging through the document, is initiated in Acrobat. 

4. Unless you have Administrative Rights for the computer you are using, ignore the ‘Internet Options’ 
section. 
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Set Options and Convert Web Pages 

1. Click on the ‘Create’ icon on the Task toolbar in Adobe Acrobat. 
2. Select ‘Create PDF from Web Page’. 
3. The ‘Create PDF from Web Page’ dialog pops up to display the URL, Settings, and Capture Multiple Levels 

options.  
4. Click on the 

Capture 
Multiple 
Levels icon to 
expand the 
‘Create PDF 
from Web 
Page’ dialog box. 

5. Select how many levels of the web page you want to capture.  (Note: capturing all levels will take a long 
time and bloat your file size.)  

6. The ‘Settings’ 
button takes you to 
the ‘Web Page 
Conversion Settings’ 
dialog box.  In this 
dialog box you have 
the General tab and 
the Page Layout tab. 

7. The General tab is 
where you change 
the conversion 
settings and the PDF 
settings. 

8. On the Layout tab, you can choose page size, margins, page orientation and scaling. 
9. After you have reviewed, all of your settings click on the ‘Create’ button.  

  



16 
 

The web page is converted into a PDF file and assigned a filename based on the web page name. 

 

 

 

 

 

 

 

 

 

 

 

Download and Convert Linked pages 

When reviewing your converted web page you will notice links 
to unconverted web pages. If you roll the cursor over an 
unconverted link, the pointer turns into a pointing finger and 
displays the unconverted URL.  To convert and download the 
page, right-click on the link and you will see a drop-menu. 
From the drop-menu, select the ‘Append to Document’ 
option.  This will download and convert the page, enabling the 
link to work; it also places a bookmark in the bookmark panel.  
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Work with Bookmarks 

While many authoring programs create bookmarks automatically that link to different sections within the 
document, you can also create your own.  

1. To add a bookmark, scroll to the page in the document that you want bookmarked. 
 

2. In the Bookmarks panel, click the New Bookmark icon.  
 

3. A new untitled bookmark is added. Click on the word ‘Untitled’ and replace it with a title of your choosing. 

 

 
Add Comments to a Document. 

1. Click the ‘Add Sticky Note’ button on the ‘Quick Tools’ toolbar. 
 

2. Position your mouse where you wish to insert the sticky note and click once. 
a. A note is added 

automatically in the 
document window. If 
necessary, click inside the 
note to create an insertion 
point, and type a short 
comment about the 
document.  

3. When you’re finished, click the 
minimize button in the upper-right 
corner of the pop-up note, or click 
outside the pop-up note. 

4. To view a sticky note, simply click once on the Sticky Note icon.  
a. The content of the sticky note will appear.  
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Edit Original Text in Adobe Acrobat X Pro 

1. Click on the ‘Edit original document text’ button on the ‘Quick Tools’ Toolbar. 
2. Position the cursor by the text you wish to edit and click once. 
3. Begin editing your text.    

 

Add Multimedia to PDF Files 

One of the new features in Adobe Acrobat X Pro is the ability to incorporate 
multimedia into PDF documents. For the purpose of this class, we will be 
reviewing how to add video to a PDF document. 

1. Click on File > Open 
2. Select and open the PDF document that you want to use. 
3. Scroll to the portion of the document where you plan to insert the 

video. 
4. Click on ‘Tools’ on the right side of the screen. 
5. Click on ‘Content’ and then select ‘Multimedia’. 
6. Choose ‘Video’. 
7. You will notice that the cursor changes into a crosshair symbol. 
8. Draw a box where you wish your video to appear on the page. 

 
 
 
 
 
 

9. The ‘Insert Video’ dialog box will pop-up. 
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10. Click the ‘Browse’ button, and then select the media file that you want to use. NOTE: You can insert FLV 

(Flash Video) files and H.264-compliant MP4 (MPEG-4 Video) and MOV (QuickTime) files. 
11. Before you click the ‘OK’ button, checkmark the ‘Show Advanced Options’ box. 
12. The Insert Video dialog box will now show the advanced options. 

 

13. On the ‘Launch Settings’ tab select the following settings: 
a. Enable when: The content is clicked 
b. Disable when:  ‘Disable Content’ is selected from the context menu 
c. Playback Style: Play content on page. 
d. Width: When you choose the ‘Play content in floating window’ option in the ’Playback Style’ 

section, you can set the width and height of the floating window in the width section. 
e. Border: You can choose to display your movie without a border or choose between a thin, 

medium or thick border. 
f. Under the ‘Poster Image’ section, make sure ‘Retrieve poster from media’ is selected and then 

click OK. 
g. Click the Play button to begin the video.  Once the movie starts to play, roll the cursor over the 

lower section of the video to see the playback controls. 
h. Stop the video and save the newly updated PDF document. 
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Create Forms 

You can create a form from an existing electronic document (for example, Word, Excel, or an existing PDF 
document) or scan and convert a copy of a form, and then add interactive form fields to it. For the purpose of this 
class, we will be learning how to create a form from an existing electronic document. 

Create a Form from an Existing Electronic Document 

1. Choose ‘Create PDF Form’ under ‘Getting Started’.   (If you 
do not see the ‘Getting Started’ menu, then you likely have 
an existing file open.  Close the file and the menu should 
appear.) 

 

 

 

 

 

2. From the ‘Create or Edit Form’ dialog box, select 
the ‘Use the Current Document or browse to a 
file’ option under ‘Choose source’ and then hit 
the ‘Next’ button. 

 

 

 

 

3. Under ‘Locate the document to convert:’, click on 
the ‘Browse’ button and locate your file.  Then click 
‘Next’. 
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4. Adobe Acrobat converts your file into a PDF and then displays a message telling you that you are in ‘Form 
Editing Mode’.  It also tells you that it has automatically detected form fields from your original document. 

 

 

 

 

 

 

NOTE: Adobe Acrobat is often not entirely successful in recognizing form fields.  Some fields go undetected, 
and some areas of the file are recognized as fields, when in fact they are not.  The clean-up work you must do 
to eliminate incorrect form fields and to create manually the form fields that the program failed to detect can 
be tedious and lengthy.   You might save time by redesigning your original document, if that is feasible, so that 
the fields are easier for Acrobat to recognize.  Notice what in your form design tends to be ignored by Acrobat 
and what tends to be picked up as a form field. 

 
Illustrated below are two converted forms from MS Word.  In the first example, all fields were correctly 
detected by Adobe Acrobat (the blue highlight color in each of the cells indicates a fillable form field in 
Acrobat).   
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In the second example, 
numerous fillable fields were 
not recognized.  Note the 
absence of the blue highlight 
color by the phone number 
entry sections and by the 
round check boxes at the 
bottom. You could not enter 
data in those spaces in 
Acrobat.   Additionally, an 
erroneous form field was 
detected and created where 
the user has nothing to fill 
in. 

 

 

 
To remove a form field that appears in error, 

1. Click once inside the form field to select it. 
2. Press the ‘Delete’ key. 

 

To add a form field that Acrobat left out, 

1. Click on ‘Add New Field’ under ‘Tasks’ on the right-hand side of the screen. 
2. Select the appropriate field type from the drop-down list (see below for descriptions of field types). 
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The following types of fields can be included in a PDF form: 

a. Text fields - allow the user to type in text such as name, 
address, email address, or phone number. 

b. Check boxes - are used by the user to choose between two 
options such as, yes-or-no or true-or-false.  A form may also 
use check boxes for making multiple-choice selections. 

c. Radio buttons - allow the user to select from a group of 
choices in which they can select only one item. All radio 
button with the same name work together as a group. 

d. List boxes - display a list of options the user can select. You 
can set a form field property that enables the user to Shift-
click or Control-click to select multiple items on the list. 

e. Dropdown menus - allow the user either choose an item 
from a drop-down menu list or type in a response. 

f. Buttons - initiate an action on the user’s computer, such as 
opening a file, playing a sound, or submitting data to a web server.  You can customize buttons with 
images, text, and visual changes triggered by moving or clicking a mouse. 

g. Digital signatures - allow the user to sign electronically a PDF document with a digital signature, which 
can be a scanned image of your signature or some other image.  

h. Barcodes - encode the input from selected fields and display it as visual pattern that can be 
interpreted by decoding software or hardware.  

 
 
 
 

3. Next, click where you want to insert the field (an outline of the field 
displays so you know where it will appear after clicking). 
 
 
 
 
 

4. Blue handles appear around the field, allowing you click on them and drag to resize the field as necessary. 
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5. It is recommended that you assign a field name that is based on the text next to it.  For example, in the 
illustration above, I would want to change ‘Check Box2’ to ‘Exempt’. 

6. Click on ‘All Properties’ to set properties for your form field. 
a. For instance, you may want to click on the ‘Appearance’ tab 

and change the font size from ‘Auto’ (which may make the 
text larger or smaller than you need) to a size that you 
determine. 

i. Note: If you want to make changes to the font size, 
for instance, of many form fields at once, you can 
highlight multiple fields on your form using the Ctrl 
key (hold down Ctrl and click on every field you wish 
to change).  Right-mouse click inside any one of the 
highlighted fields, click on ‘Properties’, and adjust your settings.  All highlighted fields will 
accept this setting change at once. 

7. Click ‘Close’ when done. 
 

When you have completed the form, you can then leave the Editing mode and preview how your information will 
look when information is entered.  To do so, 

1. Click on the ‘Preview’ button on the toolbar directly above your form. 
2. Enter information into various fields, making sure the font/font size/etc. are 

as you want them. 

3. If you need to make more changes to the layout of your form, click on ‘Edit’ on the 
toolbar directly above your form.  After making changes, click again on ‘Preview’ to see if 
the layout suits you. 

4. Remember to erase the text you entered in preview mode; otherwise, it will be 
distributed with the form. 

 

To begin entering data in your form, you need to be in ‘Editing’ and 
not ‘Preview’ mode. 

1. Under ‘Tasks’ on the right side of the screen, choose ‘Close 
Form Editing’.   

2. You may begin entering form data. 
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